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Chapter 1: Introduction
1.1 What is TracerPlus Wireless Server?

TracerPlus Wireless Server extends the functionality of TracerPlus by giving users the ability to
share real-time information over WLAN/ WAN and cellular networks. TracerPlus Wireless Server
connects TracerPlus equipped mobile workers via a wireless network, to a wide variety of ODBC
compliant applications including Access, Oracle and SQL Server among others.

Consistent with all PTS software, you do not have to be a programmer to use TracerPlus
Wireless Server. Simply create your applications in TracerPlus or TracerPlus Desktop and
connect your database to TracerPlus Wireless Server. In minutes, your entire organization is
connected with up to the minute information using the simple configuration tools.

Highlights Include:

e Live Connection to Centralized Enterprise Data

e Decreased PDA Memory Needs

e Simple Connection to Most Databases

o Real Time Visibility of Mission-Critical Data

e Sample Access Database Included

o Offline batch mode allows wireless batch synchronization

The power of TracerPlus Wireless Server lies in its automatic configuration tool. In minutes, it
automatically configures a wireless connection between TracerPlus enabled terminals and your
host data source. Mapping data is simple; just choose your host database and map your
TracerPlus fields to your host data source fields.

PTS offers user the opportunity to evaluate TracerPlus Wireless Server free of charge in order to
offer businesses the opportunity to gain hands on experience with the features and advantages
of the TracerPlus suite of applications, and to have the ability to find out how well Wireless
Sever can work for you before purchasing. If an longer evaluation is required, you can request
an extension after the initial period has ended. To purchase a TracerPlus Wireless Server
license contact your reseller or visit www.tracerplus.com for additional info.

TracerPlus Wireless Server supports both TracerPlus Standard and TracerPlus Professional
versions. Click here to learn more about the TracerPlus mobile client

1.2 Learning TracerPlus Wireless Server

In order to take full advantage of the abilities of TracerPlus Wireless Server, we strongly
recommend that you first learn the basics of TracerPlus. It is recommended that you read the
User Guide for TracerPlus Desktop, our freely available PC based design tool that provides the
most crucial information. After you have an understanding of TracerPlus, we recommend
reviewing this manual thoroughly before using TracerPlus Wireless Server.

TracerPlus Wireless Server 7.0 3


http://www.tracerplus.com/tracerplus/�
http://www.tracerplus.com/desktop/�
http://www.tracerplus.com/�
http://www.tracerplus.com/tracerplus/index.php�
http://www.tracerplus.com/desktop/index.php�

13 PTS Support

As a registered TracerPlus Wireless Server user, you receive free e-mail support for 30 days from
the date of purchase. During this period, we are available to answer TracerPlus Wireless Server
and TracerPlus questions as well as general barcode questions. However, we are unable to
support questions regarding your specific wireless network setup, unless that hardware was
supplied by PTS.

Our goal is to provide TracerPlus users the tools and information to capitalize on the efficiencies
of barcode and RFID data acquisition. Please visit www.tracerplus.com to learn more. We've
also added a number of options to our Support Center. If you can’t find what you’re looking for
there, contact PTS technical support at support@tracerplus.com.

PTS is now offering Comprehensive Support Agreements, including phone support and free
software upgrades during the support plan’s active period. One and three year plans are
available. For more information, contact your authorized reseller or PTS directly.

Additional Support and Educational References:

An easy to use knowledge base is available for all users to answer the most common TracerPlus
questions. The knowledge base is located here.

PTS provides a series of free training webinars over the course of the year, with regular
announcements via email. To begin receiving these announcements, join our Mailing List.
Some of these webinars are also recorded and posted on www.tracerplus.com in order to
provide a more flexible alternative to those unable to attend our live demos. You can
also find us on YouTube.

PTS also hosts a growing community on Facebook, Twitter and Yahoo Groups .These group
were created to offer our users a communication channel in which to discuss TracerPlus. Our
various forums can provide tips and tricks by other users while offering a way to stay up on the
latest TracerPlus news, promotions and events.

The TracerPlus.com Solution Center provides sharable mobile application samples with the
TracerPlus community. TracerPlus.com serves as a central hub for providing solutions, services,
reseller and partner information as well as providing an outlet for other aspects regarding the
TracerPlus software family.
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Chapter 2: Installation

This chapter details the steps for installing TracerPlus Wireless Server.

2.1 System Requirements

e  Windows 98/NT/2000/XP/Vista/7

e Wireless network

e 20 MB free disk space

ActiveSync version 3.5 or higher for 98/NT/2000/XP users.

Windows Mobile Device Center for Vista/7 Users

A Wireless Device running Windows Mobile, CE, CE.Net, or Pocket PC.
Trial or registered version of TracerPlus 7.0 or higher

e ODBC compliant data source

e  Optional — Microsoft Access

User Knowledge Base Requirements
e Basic understanding of networking and wireless networking
e Basic understanding of TracerPlus
e Basic understanding of ODBC and Data Sources

Note: References and instructions relating to ActiveSync in this manual also apply to the
Windows Mobile Device Center on the Vista operating system. Naming procedures of future
versions of the proprietary Windows syncing software is controlled by Microsoft and subject
to change without notice.

2.2 Installation

During the TracerPlus Wireless Server installation, the latest version of TracerPlus can be
installed to your PDA. During this process, you should not experience any loss of data or
sessions. However, we recommend that you backup your data before performing an upgrade
from a previous version. This can be accomplished by executing a File>Export from within
TracerPlus.

Note: Terminals running TracerPlus Wireless can run in either a batch mode or a Wireless
mode.

1. Download TracerPlus Wireless Server from TracerPlus.com or from an authorized
PTS reseller.

2. Onyour PC, install TracerPlus Wireless Server by running the downloaded file.

3. Following installation of TracerPlus Wireless Server, you will have the opportunity
to install the newest version of TracerPlus onto your PDA(s).

4. |If your terminal is connected via ActiveSync, the latest version of TracerPlus will
be installed. If your terminal(s) are not connected, the new version of TracerPlus
will be installed when the next connection is made and ActiveSync runs.
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23 Evaluating TracerPlus Wireless Server

TracerPlus Wireless Server users wishing to evaluate the application before purchasing can do
so by installing the software and activating it in the evaluation mode. In the evaluation mode
TracerPlus Wireless Server is fully functional for a fixed amount of time after an evaluation
code is entered. Once registered, these limitations are removed.

Initially, you are provided with an evaluation code upon the first mobile device connection to
Wireless Server. An evaluation code for TracerPlus Wireless Server can also be requested by

navigating to Tools = Registration and clicking the Request Evaluation Code button located
in the lower right hand corner of the Registration screen.

PTS Wireless - Registration @

Registration

A registration code for your PTS Wireless Server allows PDAs
to connect to the server. PDAg require either an evaluation
code [see below] or a registration code [on each PDA).

FCID Registration Code

e

* Mot Registered =

Request Registration Code

Evaluation

An evaluation code lets pou use PT5 Wireless Server for a
limited perniod of ime, and also allows unregistered PDAs to
connect to the server.

Evaluation Fequest

E—

Evaluation Code

Feguest Evaluation Code....

To request an evaluation code, click the button below.

If your computer iz not connected to the Intemet, please wvisit:

hittp: /Ao, ptehome. comdproductredirect/ TP EVALREGQUEST . php
Reguest an evaluation code using the "PC 10" and "E waluation
Reguest" values above,

Cancel

A web form is presented asking for basic contact information. Fill in the requested
information and click the Submit button. An evaluation code will appear that must be entered
in the Evaluation Code field located in the lower right hand of the Registration screen.

2.4 Registering TracerPlus Wireless Server

Although Wireless Server is fully functional during evaluation, this time frame is limited. In
order to continue to use the program, TracerPlus Wireless Server must be registered. To
register TracerPlus Wireless Server, we require your PC ID. A corresponding Redemption Link
and an e-mail address. The Redemption Link is a unique ID generated for each license of our
software you have purchased and emailed to you. TracerPlus ODBC Link is registered by
pairing this Redemption Link with the PC ID of a particular computer. The PC ID can be found
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in the registration window by clicking Tools = Registration from the ODBC Link application.
We generate a unique registration code based on this PC ID, so it is important that you send
the PC ID exactly as it appears on the computer.

Note: All terminals connecting to TracerPlus Wireless Server must also have a registered
license of TracerPlus with the Wireless Plug-in enabled. This plug-in is included with
TracerPlus Professional, but must be purchased separately when pairing with TracerPlus
Standard

How to Register:

After purchase, you will receive an email including a Redemption Link. Click on
the Redemption Link to open the registration page at www.tracerplus.com . The
Redemption Link, email address and software version will be pre-populated in the
correct fields.

Note: If you purchased other TracerPlus licenses at the same time, your confirmation
email will contain more than one Redemption Link. Be sure to select the proper link.

2.

In TracerPlus Wireless Server, click on Tools=> Registration to locate your PC ID
number.

Copy/Paste the PC ID into the proper field of the web registration form and click
Request Registration Code.

A registration code will be promptly emailed upon receipt of this request. This
process usually occurs within the hour but we ask that you allow one business day
in the event of heavy volume or other unassociated delay.

If you prefer to enter all information manually, follow the steps below.

Launch TracerPlus Wireless Server, then click Tools—> Registration to open the
registration form.

Copy your PCID, then click the Request Registration Code button to open a
registration page at www.tracerplus.com.

Enter the Redemption Link, email address and software version of your purchase
in the corresponding fields.
Follow steps 3 and 4 above.

Once you receive your registration code, follow the instructions in Section 2.5 for
entering the code into TracerPlus Wireless Server.
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2.5 Entering your Registration Code

1. Go to Tools = Registration and enter the Registration code in the Registration

Code field.
PTS Wireless - Registration E
Registration

A registration code for your PTS Wireless Server allows PDAs
to connect to the server. PDAs require either an evaluation
code [see below] or a registration code [on each PDA]).

PCID Registration Code

T m |

* Mot Registered =

Request Registration Code

Evaluation

An evaluation code lets you use PTS Wireless Server for a
limited period of ime, and also allows unregistered PDAs to
connect to the server.

E waluation Request Ewaluation Code

Bl

Reguest Evaluation Code...

To request an evaluation code, click the button below.

If your computer is not connected ta the Intemet, please visit:

http: /v, pshome. comdproductredirect/ TP EVALREQIUEST. php
Request an evaluation code uging the "FC ID" and "Evaluation
Request” values: above.

Cancel

2. Click the OK Button.

3. If allinformation submitted is correct a Thank You for Registering TracerPlus
Wireless Server message should appear.

2.6 Un-installing TracerPlus Wireless Server

In the unlikely event that you would like to remove TracerPlus Wireless Server follow these
simple instructions.

1. From the Windows Start menu, Navigate to Control Panel.
2. Select PTS TracerPlus Wireless Server and click Remove.

TracerPlus Wireless Server 7.0



Chapter 3: Modes of Wireless Operation

Chapter 3: Connecting a PDA to a Wireless Network

Wireless PDAs can easily be configured to connect a mobile worker or workforce to a pre-
existing wireless network or a single computer with a wireless network card.

3.1 Adding TracerPlus Wireless Server to an Existing Network

Your PDA can be connected to an existing network in one of two ways; the preferred method is
with a dynamic IP address using DHCP explained in Section 3.1.1. If you do not have DHCP
enabled or your IT department requires a static IP address, refer to details in Section 3.1.2.
Note: Microsoft has reserved the right to update utility names such as Mobile Companion. As a
result, the specific step by step instructions that follow will vary depending upon which version

of Windows Mobile is installed. Overall processes remain the same.

3.1.1 Connect PDA to your wireless network with a dynamic IP address using DHCP

1. On the Home screen of the PDA, click the Mobile Companion (or Wireless
Companion) icon in the bottom right hand corner and choose Find WLANSs.

r
- |5l:arl:

< Fridéw
February

i Phone off
Wi-Fi: Metwar - ﬁ
BE wireless Status
B ireless Diagnostics
| Lk

Tap hete ta

Mo tasks

B3 Manage Profiles
i Mo upcoming ap = d

ES Dptions

Cancel Menu

»  Exit

Contacks

Screen Displaying Windows Mobile 5.0
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Chapter 3: Modes of Wireless Operation

2. This should bring up a list of Available WLAN Networks.
3. Click and Hold a network, then tap Connect.

- | Find WLANS

WLAM Met,,. | Nebwark Type

For T < ok

Channel

g0z, 11(q)
Conneck (b

)]

1 (2412 MHz)
& (2437 MHz)
& (2437 MHz)

4. This will bring up a Profile Entry window
appropriate. Select Finish when done.

W= Tl

BrTs Profile Entry
[iF'TS Prafile I

W':'E hame: |

ESSID: |pT5

5. A network connection should now exist.
6. To verify you are connected to the network, refer to Section 3.1.3.

TracerPlus Wireless Server 7.0
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Chapter 3: Modes of Wireless Operation

3.1.2 Connect PDA to your existing wireless network with a static IP address
If you are unable to connect using DHCP, as described in Section 3.1.1, you can use a
static IP address.

1. Onthe Home screen of the PDA, tap the Mobile Companion icon located in the
bottom right hand corner and choose Find WLANs.

For Voo € @

Phone off ﬁ
Wi-Fi: Mebwa

&3 wireless Status
N& wireless Diagnostics

Mo unread mess
“ Find YWLANS

Tap here £

Mo tasks
B3 Manage Profies

i No upcoming ap
BY Cptions

== Log O Off
{0 Disable Radio

Cancel Menu

Dievice ul r|||'| | l::Fu:

",Tap hiere b sigr

x* Exit

Contacks

2. Alist of Available WLAN Networks should be generated.
3. Click and hold a network and tap Connect.

i | Find WLANS

WLAR Ret, ., | Metwark Tvpe | Zhannel

= PTS 80Z.11{g) 1 {2412 MHz)
Connect ()] & (2437 MHz)
(o) £ (2437 MHz)

TracerPlus Wireless Server 7.0
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Chapter 3: Modes of Wireless Operation

4. From the Profile Entry screen, navigate to the IP Entry Screen.

%F‘TS Profile

[ BPTs| rprofile ID; ——— [ MHz)

wu:ue Mame: | | MHz)
ESSID:[PT3 |

%p]’g Profile
|:IF'T5 IP Address Entry; ————— [ MHz)

wod | [oacp MHz)
DHCP \

|-::-::-::§an:k || ﬂext::—::—::—|
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Chapter 3: Modes of Wireless Operation

6. Enter the IP Address and Subnet information for your network. To configure a
Default Gateway, DNS Server or WINS Server check the Advanced box before

clicking Next. Select Finish when done.

- | Find WLANS

= Tl
BlrTs Profile Entry

[IF'TS IP Address Entry: ————— [ MHz)
wu:ue IP Address; MHz)
[192.168.4.103 |

Subnet Mask:
|z55.255.255.0 |

D Advanced

|::::::Ei_a|:k || Mext}}}|

7. To verify you are connected to your network, perform the Ping Test outlined below.

3.1.3 Ping Test

1. Go tothe Home screen and tap the Mobile Companion icon and select Wireless

Diagnostics.

- | Start

L <] Fridér
February

Phone off
Wi-Fis Mek

EE wireless Status
7 wireless Diagnostics
B8 Firg WLANS

B3 Manage Profiles

Tap here &

Mo unread mess

Mo basks

i Mo upcoming ap
85 Options

=2 Log O foff
(0 Disable Radio
Cancel Menu

revice unlockec

v.UTap here to sigr

» Exit

Contacks

TracerPlus Wireless Server 7.0
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Chapter 3: Modes of Wireless Operation

2. Select 1) ICMP Ping.

I‘- |'|'||'irE_IE55 Diagnostics L_-r Yx oz ok

Wireless Diagniostics
HJICMPPRIng
23 Trace Route
3 Known APs

43 Quit

3. Enter avalid ID Address and select Start Test.

j‘. |WirEIIE55 Diagnostics '.i"_-r Yy 4% ok

1) ICMP Ping =)
P [192.168.4.109  w|[Start Test |

Size: AP O0: 15:70:25:80:50C
Signal {dBm): B -+

Moise {dBm); W ]9

SR {dE): [ BN

Tatal Tax: 0

Tokal R

Last:

Last BT Time (ms):

Avg BT Time (ms;

Min BT Time {msy:

Max BT Time {ms);

% 54 Mbps:

% 48 Mbps:

%= 36 Mbps: -

el N e

[+]

4. If a successful connection is established, a green bar will appear corresponding to
the specific speed of your connection.
5. Tap the Back Arrow, then Select 4) Quit.

Note: If you have not setup your wireless router or access point please consult your
device’s user manual.

TracerPlus Wireless Server 7.0
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Chapter 3: Modes of Wireless Operation

3.2 Operating TracerPlus Wireless Server in Adhoc Mode

TracerPlus can be operated from PCs and Laptops that are not members of a network by setting
them up in Adhoc mode. To accomplish this, you simply need a wireless network card.

3.2.1 Configure the PC or laptop’s TCP/IP Settings

1. Right click My Network Places and select Properties.
2. Right click your wireless adapter and select Properties.
3. Double click Internet Protocol (TCP/IP).

-4 Wireless Neiwork Connection Properties E”‘}__q

General ! Wireless Mebwarks E..-'1'-.|:h-'emu:eu:l5

Connect uzing:
B Dellwicless WLAN 1350 WLAN Mi

Thiz connection uges the following terns:

% Client for Microzoft Metworks
.@ File and Printer Sharing for Microsoft Mebaorks
QBDS Packet 5cheduler

(- Internet Protocal [TCRAAR)
Deszcription

Tranzmizzion Control Protocal/lntemet Protocol. The default
wide area netwark, protocol that provides communication
acrozs diverse interconnected networks.,

[ Shows icon in natification area when connected
Matify me when thiz connection hasz limited or no connectivity

Ok ] [ Cancel
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Chapter 3: Modes of Wireless Operation

4. Select Use the following IP address and enter an IP. Ex: 192.168.1.10
5. Set Subnet Mask to 255.255.255.0

Internet Protocol (TCP/IP) Properties

General |

You can get [P zettings azsigned automatically if your network, supports
thiz capahility, Othensize, you need ta ask your nebwark, administrator for
the appropriate [P zettings.

{7 Obtain an IP address automatically
{#) Use the following IF address;

IP address: | 192 168 . 1 .10

|
Subnet mask: | 255255255 . 0 |
|

Default gateway: |

(%) Use the follawing DMS server addresses:
Freferred DMS server: | . . . |

Alternate DMNS zerver | . . . |

[ aF. ][ Cancel ]

6. Click the OK to exit.
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Chapter 3: Modes of Wireless Operation

3.2.2 Setup the Ad Hoc connection on your PC or Laptop

1. Right click My Network Places and right click your Wireless Adapter and click

Properties.

- Wireless Network Connection Properties E”'SZ|

General | wireless Networks | Advanced |

Connect uzing:

BE Dall'wireless WLAN 1350 WLAN Mi

Thiz connection uses the following items:

% Client for Microsoft Metworks

.Q File and Prinker Sharing for Microsoft Metwarks
.@ (a5 Packet Scheduler
Internet Protocol [TCPAR)

Properties

[ Install... ] U rinztall [

Dezcription

Transmigzion Cantral Protocal/Internet Pratocal. The default

wide area netwark, protocol that provides communication
across diverse interconnected netwarks.

[ ] Show icon in notification area when connected
I atify me when thiz connection has limited ar no connectivity

ak ] [ Cancel

TracerPlus Wireless Server 7.0
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Chapter 3: Modes of Wireless Operation

2. Select the Wireless Networks tab.

-+ Wireless Network Connection Properties E”E'

Uze Windows to configure my wirgless network, settings

Aeailable networks:

To connect to, dizconnect from, or find aut maore infarmation
about wireless netwarks inrange, click the button below,

Wiew Wireless Nebworks

Preferned networkz:
Autamnatically connect to available networkz in the arder ligted
bl

A METGEAR [Automatic] L b ove up
i PTS5_CAL [Marual]
A chwifi [Automatic]
A horn [Automatic]

Mowve dowvn

[ Add... ][ Femove ][ Froperties ]

Learn about getting up wirsless nebwork

configuration,

[ )8 H Cancel ]

3. Click the Advanced button located in the lower right hand corner of the screen.

TracerPlus Wireless Server 7.0



Chapter 3: Modes of Wireless Operation

4. Select Computer-to-computer (ad hoc) networks only.
5. Click Close to exit.

Advanced

Metwork s to access
{3 Any available netwark [access point prefered)
() Access point [infrastructure] netwarks only

{(#) Computer-to-computer [ad hoo] netwarks only

[ ] Sutomatically connect to non-preferred networks

Cloze

6. Inthe Preferred networks area of the screen, click the Add button.

-4~ Wireless Network Connection Properties E|[E|

G eneral ! Wwirelezs Metworks i ;l‘:.d'.'.'ancedl

Uze Windows to configure my wirelezs network, zettings

Available nebwork s

Tao connect to, dizcannect from, ar find aut mare infarmation
about wireless netwarks in range, click the button below,

Wiew Wwireless Mebworks

Freferred networks:
Automatically connect to availlable networks in the order listed
bl

4 MNETGEAR [Automatic) o bMove up
L PTS_CAL [Manual]

A chwifi (Automatic) i

A hormn [Sutomatic] R

[ Add... ][ R emove ][ Froperties ]

Learn about seting up wirsless network

configuration,

[ Ok H Cancel ]
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Chapter 3: Modes of Wireless Operation

N

Enter a Network name (SSID) for this connection. (i.e. PTSWireless).

In the Wireless network key area set Network Authentication to Open.

9. Set Data encryption to WEP or you can disable it, if necessary. In this example, it is
set to Disable.

10. Select OK and OK again to exit.

%

Wireless network properties

Agzociation | Authertication | Cornection |

Metwork name [S510]; |F"T Shwfireless |

Wirelezs network key

Thiz netwark requires a key for the following:

Metwark Authentication: |I:I|:|en v|

C'ata encryption: | WEP v |

Fay indes [advanced) 1

The key iz provided for me automatically

] o e B P gl 2 B i 0 e L et g
| iz 15 a computer-la-computer |ad noc] nebsark: wirsles:

ACCEEE poink: are nok

[ 0k, ][ Cancel ]

11. You should now see your wireless connection as shared.
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Chapter 3: Modes of Wireless Operation

3.2.3 Connect to your PC or laptop from the handheld

1. Inthe bottom right hand corner of the Home screen click the Mobile Companion
icon and select Find WLANSs.

“|Mobile Companion £ £ 2:22
) Tuesday, January 18, 2005
Tap hete ko sek awnet information

Mo unread messar

Status
WLAN Profiles
Find WLANs
Options

New @ g

Screen Displaying Windows Mobile 2003

2. PTSWireless will be listed in Available WLAN Networks.
3. Tap the Connect button.

TracerPlus Wireless Server 7.0
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¢ i#|Mobile Companion ¥ 4 2:23 @

Hevailable WLAN Nebworks
HPTs _caL Connect

[T ]

I [ [ [» Close

E|A

4. Configure Authentication and Encryption if necessary.

: 4 |Mobile Companion o+ < 2:27 9

-ireless LAN Mode
Prafile Mame

|PTSWireIess |
402,11 ESSID:
|PTSWireIess |

Ciper ating mode:;
|.ﬁ.|:|-H|:u: - |

Counkry: |LISF'. - |

|:| Long preamble
Channel Mumber; |10 -

Mode | Authentication | Encryption | IPcCol 4]k
|

5. Tap the IP Configuration tab and select Static from the drop down menu.

TracerPlus Wireless Server 7.0
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Chapter 3: Modes of Wireless Operation

Muhile Companion {7} =< 2:28 9

-IP Configuration

IF Address:  |192.168.1.11
Subnet Mask: |255.255.255.0

|
|
Gateway: | |
|
|

DS |
WINS: |
Authentication | Encryption | IF Config PEI

E|*

In the IP Address field, enter 192.168.1.11.

In the Subnet Mask field, enter 255.255.255.0.

Tap OK to connect.

You can verify your connection by clicking the Mobile Companion icon in the
bottom right hand corner and selecting Status.

©oNo

“|Mobile Companion &F =< 2:31

) Tuesday, January 18, Z005
Tap here to set owner information
Mo unread messages
Mo basks

i Mo upcoming appoinkments

WLAN Profiles
Find WLANMs
Options

10. In Known Peers you should see the PC’s or laptop’s Mac address listed.
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¢ 7 |Mobile Companion gF 4 2:32 9

rknown Peers
Peers MaC | Power Mode I Tr
00:0B: 7008 96:E2  (CAM 11
1] I [ [ »
Info | IF Status | Peers |
E|‘
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Chapter 4: Configuring TracerPlus Wireless Server

Chapter 4: Configuring TracerPlus Wireless Server
4.1 Setting up Wireless Server
Launch Wireless Server on your PC.

Go to Application Settings

PTS - TracerPlus Wireless Server - [Client List]

File Server ‘View Tools Help
) i
Main Screen
Lsermame Client | Session Trans... Connected Last Mza
ith 2 n y 5 : -05 2 07
ODELC Configuration
N
M Application Settings Lerver Monitor Client Monitor
Client: JSmithi@192.168.4.105
Marme:  192.168.4.105 Model  MA&
Description: - Oper. Syz.:  Pocket PC
= Username:  JSmith Software:  TracerPlus
£ § . .
23 Exit Senal #: 02663400-0041D255 “erzion: 1.6.1
Feq Code: 572412293
Status:
Mezzages: BolGi Seszion:  #1: Inventon Track
Bytez:  17220/B35i Flugin: PPTP_Pw ver. 1.6.1
Connect Time:  Jul12 18:16:05 Ses. Reg oo
Last Message:  Jul12 18:16:07 ODBC DSN:  PTS_TracePluswireless
ODBC Table:  Sessiondl
Jul12 18:15:23 Server PC-116-891-6509 iz UMREGISTERED. Please visit v ptshome. com to register.
Ju12 18:15:23 Evaluation activated, expires 7/12/2005 10:00:00 PM
Jul12 18:16:05 Disconnect from HHH
Jul12 18:16:05 Connect from 1921684105 ()
Jul12 181606 JSmithis 132 168.4.105 open Session] (Inventory Track)
Connected clients: 1 Server enabled on 192, 1684, 16:4402
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Modify Application Settings if necessary. Application Settings are pre-set to defaults as seen

below.

Modify Server Settings, Network Settings, and Logging Settings if necessary.

PTS - TracerPlus Wireless Server - [Application Settings]

File Server Tools Help

I ain Screen

ODBC Configuration

Application Settings

Néle

HE“ Data Wiewer

o Eyit

1

I

Connected dients: 0

Save Settings

Server Seftings

Server Name
|F'TS Wwireless Server

Dizabled Message

[w Server Enabled

|Wireless zerver iz not cumently enabled.

Metwork. Settings
Server [P &ddress v Enable Encoding

192.168.4.16

Server Part Number

4402 Usge Default

Loggihg Seftings
LogFile [ “erbose Logging
|D:\PTSWireIessLog.t>:t

View Logfile.. | Clear Logfll.. |

Server enabled on 192, 168.4. 16:4402

-

Click Save Settings.

or laptop.

Note: Confirm that the IP address appearing in the Server IP Address field corresponds to your PC

TracerPlus Wireless Server 7.0
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Chapter 4: Configuring TracerPlus Wireless Server

4.2 Handheld Configuration

1. Open TracerPlus on your PDA.
2. Select the Configure Tab and choose Wireless Settings.

J'r"’ | PTS TracerPlus ';,"_-i Xy o
rRcEiPius
Corifigure | Data Entry | View Data |

n N o=

Session Field Printers
Settings Settings
ET?} < E@
Wireless Passwords
Settings

Last Sync: nfa
File Options Admin Help o

3. Select the Session matching the current session being configured in Wireless Server.

[ ] Enabled
Host address: | |

Port:

PDA MickMarne

|

Done

File Options Admin Help

4. Check Enabled.
5. Enter Server IP Address in the Host Address. Enter the Port and the PDA
NickName.

TracerPlus Wireless Server 7.0 27



Chapter 4: Configuring TracerPlus Wireless Server

6. To test your connection, Tap the Connect button.

Enabled
Host Address: |1g2,1|§.a,4,12 |

Paort:

PDA MickMarne
vour PDA Mame Herd |

Done

File Options Admin Help

7. At this time you should see the Connected to: message as seen below.

Connected to:

Ef 192.168.4.12
Hast Joe's Wireless Server
b= 5.0,0,335

PDA MickMarne
Your PDA Mame Here |

Done

File Options Admin Help m

Note: If you should receive an error after tapping Connect, please refer to Chapter 6 for
troubleshooting suggestions.
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TracerPlus Wireless Server is pre-configured with a sample database connection. After the
setup process is successfully completed, data should transmit between the PDA and the sample
database. Please proceed to Section 4.5 to learn how to test your PTS wireless connection.

4.3 Connecting to an Existing Database

From your PC Start menu navigate to Start-=>Settings—> Control Panel.
Double Click the Administrative Tools Icon.

Double click the Data Sources (ODBC) icon.

The ODBC Data Source Administrator window will appear.

PwnNR

£ ODBC Data Source Administrator

Uzer DSN | Spstem DSN] File DSN] Driversl Tracing] Connection F'Du:nlingl s bot l

Uszer Data Sources:

| Diiver | Add..
Microsoft dB aze Diriver [~ dbf]
Excel Files Microsoft Excel Driver [ «ls] Remaove
M5 Access Database  Microzoft Access Driver [*.mdb)
Yizual FoxPro Databaze  Microsoft Wisual FoxPro Driver Configure. ..

Yizual FoxPro Tables Microsoft Yisual FoxPra Driver

An ODEC Uszer data source stores information about how to connect to
the indicated data provider. & L zer data zource iz anly visible to you,
and can only be used on the current machine.

k. | Cancel Help
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5. Select the System DSN tab and you should see the PTS TracerPlus Sample DSN
listed with System Data Sources.

1 DDBC Data Source Administrator

Usger D5M  System DN l File DSM ] Dlivers] Tlacing] Connection F'Daling] About ]

Swuztem Data Sources:

Mame | Driver | Add...
Avastd Microsoft Access Driver [*.mdb]
SENNEEE E R Microsoft Access Drver (.mdb] Bemaove
TrioMotors Microzoft Access Driver [*.mdb]

il

Canfigure...

An DDBC System data source stores infarmation about how to connect ta
the indicated data provider. & System data zource iz visible to all users
an thiz machine, including NT zervices.

oK | Cancel Help

6. Select PTS TracerPlus Sample and click Configure.
7. This will present the ODBC Microsoft Access Setup window.

ODBC Microsoft Access Setup

Data Source Mame: |F'T5 TracerPlus Sample 0k |
Deszcnption: |DDBELink Diiwer
Cancel
Databasze
Database: C:h. AODBC LinkBA\D atak T racerPluz.mdb Help
Select... | Create. .. ‘ Repair... Compact. .. ‘
Advanced...

Systemn Database

& Mong

" Database:

[ beins.

Ophionzs»

I
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10.
11.

12.
13.
14.
15.

TracerPlus Wireless Server 7.0

In the Database section click the Select button to bring up the Select Database
window.

Select Database

D atabaze Mame Directories:
TracePlus. mdb c:h hptzhodbe linkShdata
Cancel
TracerPluz.mdb = ch
[ Program Files
= PTS Help
[=+ ODBC LinkE [ | BeadOriy
Dat -
& Data [ Exclusive
Lizt Filez of Type: Drives:
|.ﬁ.ccess Databases [“.mj | B j Metwark...

Under Drives: select the hard drive where your database is located.

Under Directories navigate to the folder containing your database.

Once you are in the directory you should see your database appear in the Database
Name window.

Select the database and click OK.

Click OK and OK to close the remaining open windows.

The PTS TracerPlus Sample DSN is now configured to point to your database.
Proceed to Section 4.4 to configure your Sessions.
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4.4 ODBC Configuration

The ODBC Configuration form is opened by selecting the ODBC Configuration icon,
located in the left hand column on the Main Screen. Configuring this form properly
enables TracerPlus Sessions to connect to ODBC Data Sources.

PTS - TracerPlus Wireless Server - [ODBC Configuration]

File Server Tools Help
@ tain Screen
Session 1 Session 1 Enabled v
Session 2
Session 3 Name
ODEC Configuration ||| Session 4 Session 1
Session &
Session 6 ODBC data souce settings Field mapping and advanced options
Session 7 7
tpplication Gettings || Session & Select your DDBC data souce Fredeoans ] Lo UPtIDﬂS]
Session 3 FDA Field FC Fiekd ~
Session 10
= Sesgion 11 DS
‘ Session 12 T = = Field02 Field2
Jlo=ilere Sessin 12 . Fieldl3 Fielda
£3si0n " "
- Session 15 Field04 Figldd G
: Session 16 Database Username Field03 Field3
L2 Exit Session 17 [— Field0& Fields @
= Session 13 Fieldd7 Field?
Session 19 - . o
Session 20 Database Password Field02 Fieldd 2
Session 21 [— Field03 Field3 %
Seesion 22 Field10 Field10
Gession 24 Field11 Field11
Session 25 Table Read Only [ Field12 Field12
Session 26 D 3 i i
Session 27 ‘Sesslonm ﬂ F!EIEH 3 F!el\:ﬂ 3
Gession 28 Field14 Figld14
Session 29 Key Fisld Field15 Field15
Session 30 Field15 Fild15
Session 31 [ - [ 5 5
Cession 32 ‘ J Field17 Figld17
Figld18 Field13
Field19 Field13
Field20 Figld20
Field21 Field21
Field22 Field22
Figld23 Field23
Field24 Field24
Field25 Figld25
Field26 Field?6
Field2? Figld27
Figld28 Field28 b
< bd
Connected dients: 0 Server enabled on 192. 1684, 16:4402

The first step in configuring TracerPlus Wireless Server is choosing the TracerPlus Session the
Data Source will connect to. Select the Session from the Session List, located in the left hand
column of the configuration screen and configure the additional settings described below.

Enabled Checkbox

The Enabled checkbox allows the user to turn a session on or off. When a session is enabled it
will allow connections from the device. If the session is not enabled, it will prohibit the
connected device from accessing the session and no new data is transferred.

Name
The Name field allows the user to change the name of the selected Session. The designated
Name will appear next to the Session number for easy reference.

ODBC Data Source Settings

After the TracerPlus Session has been selected, named and enabled the user must then
complete the fields in the ODBC Data Source Settings area.
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DSN
Select the Data Source Name (DSN) in this field. The drop down list will list all the currently
configured DSNs on your system.

Note: You can create/modify DSN configurations by using the Control Panel applet
called "ODBC Data Sources" or "Data Sources (ODBC)". You may find this under
Control Panel > Administrative Tools, depending on your operating system version.

TracerPlus Wireless Server creates a sample DSN called "PTS TracerPlus Sample",
which is pre-configured to connect to the included Microsoft Access database. You
can modify this DSN for your own needs, or create a new one.

s

DSN Refresh Button
Click the DSN Refresh button at anytime to refresh the DSN drop down list. Use this if the DSN
list is changed while TracerPlus Wireless Server is running.

Database User Name

A User Name is required by some databases in order for ODBC to connect. The ODBC
configured database User Name can be entered in this space. TracerPlus Access Database and
many others do not require a User Name so leaving it blank is acceptable.

Database Password

A Password is required by many databases for ODBC to connect. The ODBC configured
database Password can be entered in this space. TracerPlus Access Database and many others
do not require a Password so leaving it blank is acceptable.

Read Only Checkbox
The Read Only checkbox restricts the mobile worker’s editing abilities for the session. This is
especially useful in providing references in the field.

Table

After the ODBC Data Source is selected the appropriate table must be selected. Choose the
Table you intend to sync data with. The dropdown list will list all the tables within the selected
DSN.

Y
Table Refresh Button
Use the Refresh button next to the table drop down to refresh this list. Use this if the tables in

the data source have changed while TracerPlus Wireless Server is running.

Key Field
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The Key Field is required. Select the primary key of your database from the drop down menu.
The drop down menu will list all available fields in the selected data source.

Key Field Refresh Button
Use the Refresh button next to the Key Field drop down to refresh this list. Use this if the table
structure of the selected table has changed while TracerPlus Wireless Server is running.

Update Options Tab
Use the Update Options tab to set options for wireless signature transfers. A screenshot of this
tab is below.

22 PTS - TrocerPlus Wireless Server - [GDBC Configurat - ] ) ] |

|EI|E Server Tools Help
) = T
&Q”” oo | I S St
Session 1 Ensbled v

e Sesman 02
Sezsion 13 Mame:
DDBE Configuration | | Sezsian 04 [Session 01
Sespion (5
| Setsion 05 Daa soLEce salling: Field mapping and advanced oplions

Segzian 07 5 3 .
y Fiekd Mapping Updueﬂ:-lm|
Session (5
g Spplcalion Sclings ||z vvion 09 File Setlings

Session 10

i Seesion 11 BSM lSen'e ImagesSignabues 1o cuslom path
N Seszion 12
| Data Viewer Sestion 13 [PTS TiacedPhu: & aelel = K3
Sesson 14 [T Save Signatures as Jpegs
Sesion 15 . "
= Setsion 16 Dalabassamamns Signature Blename fiekd
i Ext Session 17

| g::ﬂ:g ™ Transder Saonahee a3 OLE Objects

Seszion 20 D siabase Password
Sezxian 21

Sespion 22

Setion 23

Sesson 24

ges-s'm g Table ReadOny [

SIT0N L n

Gestion 27 [Sezsiondl =]
Session 28
Sespon 29 3
Segrion 20 Eay Finkd

Sestion J1 I-E ;I
Session 42

(%]

(%]

fConnmed clients: 0 Server enabled on 192.168.4.31:4402

Signature and Image transfer options
Signature capture is a feature available in TracerPlus Professional. There are currently 3 ways to
transfer signatures and 2 ways to transfer images via TracerPlus Wireless Server.

Option 1: As an External File

If you map a TracerPlus signature or image field to a Standard Text or String field in your
database, this signature is transferred as an image file to a folder on your PC. The
default path for these files is: C:\Program Files\PTS\TracerPlus Wireless Server
7\Data\Bin.

Save Images/Signatures to custom path
You can override the default path listed above by entering an specific location in this
field.
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Save Signatures as Jpegs

By default, external files are transferred as .BMP images for Signature files and .JPGs
for Image files. You can choose to save Signature files as JPGs by enabling the Save
Signatures as Jpegs checkbox.

Signature Filename field—Signature Files only

Also by default, the external file created is named with an automatically generated
unique filename based on the specific variables at the time of capture. This name is
also written to the mapped field in your ODBC data table for easy access after the
transfer is complete. For signature files, you can create a custom name for the image
based on the data from another field.

Note: This association is based on the field index value, rather than the field
number itself. As a result, you must subtract 1 from the number of the field you
wish to pull data from and enter that into the Signature filename field.

Example: Field 10 may be a text field assigned to document the printed name of
the signatory, while field 11 is assigned as a Signature field. By entering 9 in
Signature Filename field, the automatically generated field name is replaced with
the information entered into field 10. In this case, the Signature filename would be
the printed name of the signatory.

Option 2: As raw data

If you map a TracerPlus signature field to a BLOB or Memo field in your database, the
signature or image data is transferred to that field as a raw data. The contents of this
field will contain the same information as a standard generated image file but it is
contained (embedded) directly in your database. As a result, no external file exists. This
is useful for many databases and is the required method in some cases when these
signatures are used in a generated report or other means of displaying the data. This
tends to vary per database application or report generation software.

Option3: As an OLE Object —Signature Files only

Similar to a raw data transfer, a TracerPlus signature field can be transferred to a BLOB
or Memo field as an Embedded OLE object. Like a raw data transfer, some database
applications and/or report generators prefer images to be stored/embedded in a
database as an identifiable, embedded OLE object. Microsoft Access is a good example
of this. This setting is only relevant if the mapped field is an OLE or BLOB type field. If
the field mapped to a signature is a standard text field, this setting is ignored.

4.5 Test Connection

To test your connection simply begin collecting data in TracerPlus, you should be able to view
your data from Tools = Database Viewer as discussed in Chapter 5.
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Chapter 5: Managing Data with TracerPlus Wireless Server
5.1 Database Viewer
Select the Data Viewer button from the Main Screen to view, edit, and filter

Session data. Using the Session drop down list in the top left you can switch
. between the different sessions and view the table data.

|51:ssic-n1 L 3 57 \z : EH & _.::. x ':é}‘ T | A Md | A S
¥ Fieldl  |Field2  [Fiekd3  |Feeldd  [Field5  [Fieids  [Field?  [Field8  [Fieidd  |Fieldi0 [Fiekd11 [Fieldi2 [Fiek ~
4
o
| € »
Database: PTS_TracerPlus_PPC Table: Session01 Rowes: 0

The Database Viewer displays the ODBC Data Source data as defined by the Session Settings
and the DSN connection for that session.

Data Viewer Toolbar

AVLCIE L TR G| TP RS
F

+ + +
Table Mavigation Table Editing Fiter Font! Column Size
Table Navigation

Use these buttons to move one cell in the desired direction. (From left to right) move
one cell up, move one cell down, move one cell left, and move one cell right.
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Table Editing

These buttons allow the user to edit records in the table. (From left to right) edit field,
insert new records into the table, commit changes, delete records from the table, and
refresh the table.

Filter

This button allows the user to filter the table. When selected a prompt is displayed to
enter the filtering criteria. When a filter is set the current filter criteria and number of
rows is displayed in the status bar at the top of the data viewer. To remove the filter,

click the filter button again or select Remove.

Filter Status Bar

Curent fiter: [[ID] >34° Remove |  Edit |

When a filter is set, the Filter Status Bar is displayed at the top of the data viewer. The
Filter Status Bar displays the currently set filter. From the filter status bar you can
remove the current filter or Edit the current filter. When Remove is selected, the filter is
removed and the data is presented again with no filter applied. When Edit is selected
the filter prompt is displayed allowing the user to change the filter. When finished, the
new filter is displayed in the Filter Status Bar.

Font/Column Size
Use these buttons to change the data viewer to your preferences. (From left to right) Increase
column width, decrease column width, increase data font size, and decrease data font size.

5.2 Logging Window

The Logging Window displays TracerPlus Wireless Server activity. This window can be disabled
by selecting View—>Log Info>Show. Messages sent to the window include the following:

e When the server is enabled or disabled.

e When a PDA in the field connects or disconnects.

e Error Messages received from the Data Source.

e Registration Status.

5.3 Detail Monitor
The Detail Monitor displays information regarding the Wireless Server and the selected PDA
from the connected PDA client list. You can hide the Detail Monitor by clicking View=>Detail

Monitor or selecting the Detail Monitor icon from the toolbar.

Server Monitor
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The Server Monitor tab displays the TracerPlus Wireless Server version, the total number of
PDAs connected, the port the TracerPlus Wireless Server is running on, and location of the
server’s configuration file and log file.

Server Monitor Client Monitor ]
Server
Mame: PTS Wireless Server Start Time:  Jul-05 13:25:55
Verzion:  2.0.0.1 Total Bytes:  35430,/939
Server Port: 4402 Tatal Clients: 1

Config. File:  D:APTS'owe_repozitonies\developmenthProjectzwirelezsS erver\P T SWirelezs. ini
Log File:  D:APTShove_repositoriestdevelopmentProjectz\wireleszS erverPT S'wWirelessLog. tut

Client Monitor

By selecting a client in the client list, you can view the information for that client in the Client
Monitor. This includes the name, model of the PDA, operating system, username, version of
TracerPlus, Serial # (Device ID) of the PDA, and the registration code if the PDA has a valid
registration of TracerPlus Wireless.

The Status section shows information regarding the messages sent and received from the PDA
and the ODBC data source which TracerPlus Wireless Server is connected to.

Server Monitor Client Monitor l

Client: PDA1@@192.168.4.158

MName: 192.168.4.158 Model:  M/&
Description: - Oper. Sys.: Pocket PC
Usemarne: PDAI Software:  TracerPlus
Senal#: 03322B00-CA44DEF2 Version: 5.0.0
Feg Code: -
Status:
Meszages:  2o0/2 Sesgion: -
Bytes:  8920/3500 Plugin: -
Connect Time:  Jan-21 12.16:46 Ses. Reg: -
Last Meszsage:  Jan-21 121648 ODBCDSM: -
ODBC Table: -
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Chapter 6: Troubleshooting

In this chapter, some of the more common issues you may run into when configuring your
TracerPlus wireless environment are discussed. This is not a complete list, but may be helpful in
resolving the more common issues. If this list does not contain an answer to your issue please
e-mail the PTS Technical Support group. If it is determined that the issue is related to your
internal network configuration, PTS may not be able to help. In this case, you would need to
speak to your network administrator to resolve the issue.

6.1 PDA Wireless Network Connection Issues

If you are unable to connect your PDA to your network via a wireless connection, this is
most likely a network configuration issue specific to your network. Review the settings
and procedures in Chapter 3 to see if you can resolve the issue. If not, you may have to
contact your network administrator for assistance.

6.2 PDA to TracerPlus Wireless Server Connection Issues

If you are unable to connect your PDA to TracerPlus Wireless Server, review the items
below to see if any suggestions resolve the issue. If none of these issues appear to
resolve the issue, contact the PTS Technical Support group for assistance.

Verify that the server is running on a PC that is available to you on your network
Verify that the PC Server is not blocking your selected port through a firewall.
Verify that the PDA’s Host IP and Host Port settings are correct and match the
server you are trying to attach to.

Verify you are able to Ping the host PC from the mobile device using the Ping
Test utility outlined in Chapter 3.1.3

Verify that you are able to ping your mobile device from the host PC.

6.3 Errors on PDA after Connection to TracerPlus Wireless Server

This could be the result of any number of issues, depending on the error presented. If the
suggestions below do not resolve the issue, please contact PTS Technical support for assistance.

Registration Status issues:

Verify registration status or evaluation code status via the TracerPlus Wireless
Server PC application. This is available under Tools=> Registration. The server
and PDA both require registration so it is possible that while the server is
registered, your individual PDA may not be. In this case, you need to either
purchase a PDA license or, if possible, extend your evaluation code via
Tools>Registration.
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Session Selection issues:

- Verify that the selected Session is valid and enabled on the PC Server. This can
be checked via the menu ODBC Configuration screen. Be sure that the enabled
checkbox is selected. Be sure all settings are correct, check if DSN is valid, and
the database exists.

Data posting/update issues

- Besure you are not violating the database primary key settings.
- Be sure that any data to be entered conforms to your database field properties.
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